
Introduction
ZipWorks is a full featured 32-Bit Zip file manipulater for Windows 95. The built-in 32-Bit compression is
fully compatible with PKZIP v2.04. With this program you can Zip, UnZip, add comments to your Zip 
files, test archive integrity, and repair damaged Zip files. This program can creates files across multiple 
disks, and can store directory structure, making it a pretty fair choice for a backup utility, though its 
“cousin”, Safety Net Pro, might be a little better suited for that purpose. The primary help engine for this
program revolves around the context-sensitive help concept that Windows 95 makes such liberal use of. 
Simply click on the small help icon in the upper right corner of any of the dialogs (except the main one), 
then click on the item in question, and an explanation of that item will be forthcoming. Access to context-
sensitive help in the main dialog is achieved through the Help Menu. Simply choose the item, Whats 
This?.
There is an option in the Preferences dialog to associate ZipWorks with the file extension “ZIP”. We 
highly recommend that you take advantage of this very useful feature, which will add 3 right-click menu 
items to your appropriate zip files in Explorer - open, UnZip, and UnZip To Path.



Zipping And Unzipping Files
To use ZipWorks to create a zip file, follow the simple steps as outlined below:
1. Click on the New Zip File button.
2. In the ensuing dialog, choose both the path and the name of your proposed zip file.
3. Click on OK.
4. In the next dialog to appear, use the file dialog section on the left to choose the files you wish to 

include in the zip file. If you are uncertain of the function of any of the controls, please use the 
context sensitive help.

5. Click on OK.

ZipWorks offers several ways to unzip files. The simplest way does not involve loading the program at 
all. If you have chosen to associate the ZIP file extension with ZipWorks, you will find 3 new right-click 
menu items when accessing zip files in Explorer: 
UNZIP does just that - the entire contents of the file are unzipped right there, no questions asked. 
UNZIP TO PATH is quite similar, with one exception. A dialog will appear asking where you would like 
the contents of the zip file deposited.
OPEN loads the file in ZipWorks.
Once a zip file is loaded in ZipWorks, individual files can be extracted by selecting them with the 
mouse. If either all or none of the files are selected, the entire file will be extracted to the path that you 
select in the dialog that will appear after choosing the EXTRACT button.
For complicated unzipping proceedures which require you to see the full path of the files that you would 
like to restore, choose VIEW / SHOW PATH INFORMATION from the menu. Any files selected in this list
will also be selected in the main dialog when you close the Path dialog by clicking on the OK button.



Zip Options
The Zip Options dialog allows you to customize the behavior of ZipWorks in a multitude of ways while 
creating your Zip files. You have a choice of setting these options for the file you are about to create, or 
saving them as your default.

Encrypt
Delete Original Files
Recurse Directories
Store Directory Information
Shorten Long File Names
Multiple Disk Zip File
Specify Temp Path
Add Comment
Compression Level
Zip - Add
Zip - Freshen
Zip - Update



UnZip Options
The UnZip Options dialog allows you to customize the behavior of ZipWorks in regard to how it treats a 
Zip file while it unzips it. You have a choice of setting these options for the file you are about to create, or
saving them as your default.

Use Decrypt Code
Restore Directory Structure
Update Only



Integrating ZipWorks With Explorer
You can integrate ZipWorks with Explorer quite nicely by checking the Associate Zip Extension With 
ZipWorks option in the Preferences dialog under the Options menu. This will allow you to load a Zip 
file into ZipWorks by simply double-clicking on it while in either Explorer or File Manager. In addition, it 
will create the right-click menu item UnZip, which will only appear when an appropriate Zip file is 
accessed in this way. When called, UnZip will do just that - the file will be unzipped immediately, no 
questions asked, right where it stands, and without taking the time to load ZipWorks. A third menu item 
will also be added - UnZip To Path. This is very much like UnZip, but a dialog appears, allowing you to 
specify a directory in which to place the unzipped files. This feature, combined with Explorer Auto-
UnZip , can make ZipWorks function almost like a command line utility - just double-click on a file, and 
it’s automatically unzipped.



Checking this option will allow you to enter the code required to unZip an encrypted Zip file. Attempting to unZip 
such a file without providing the code will generate an error.



This allows you to use a test mode in which the ZipWorks acts as if it is extracting items but files are never written. 
This is useful to verify that each item in the Zip file can be uncompressed without an error.



This will allow ZipWorks to create whatever directory and subdirectory information is stored in the Zip file. Setting 
this option will have no effect on the unZip operation if there is no directory information in the file, so, unless you 
specifically do not want directory structure restored, we recommend that you leave this option checked as the 
default.



Indicates that only those items that do not already exist or that are more recent than their corresponding items in the
Destination are selected for operation.



Checking this option will allow you to enter a password, or encryption code, into the Zip file. This encryption code 
can be up to 65 characters long, and is a very effective lock that cannot be opened without the key. There is no way 
to retrieve the code from the file, so be certain you don’t forget it.



This is a good choice for those of you trying to squeeze everything you can out of a crammed hard drive. After the 
files are safely tucked away in the Zip file, ZipWorks will delete the original files as part of the Zip operation if this 
option is chosen.



Choosing this option will cause ZipWorks to look in nested directories for the file specs you have specified. Used in 
conjunction with the Add Special button in the Add Files dialog, this can be a very powerful tool, since ZipWorks 
does allow for wildcard entries.



This option will enable ZipWorks to store the full path for each file being added the Zip file. This information can be 
extracted when unZipping the file, or ignored, as you choose.



There are certain 32-bit file name characters that will cause 16-bit unZipping utilities to choke and gag. With this 
option chosen, ZipWorks will truncate long file names, and remove any spaces from the name, making the file 
completely accessable    to any PKZIP v2.04 compatible unZipping utility.



Multi-volume support (disk-spanning) allows you to create and write a Zip file to a removable drive, even if the Zip 
file is too large to fit on a single volume. For example, if your application is writing a Zip file to a floppy disk drive, 
and the first diskette becomes full, the end-user is prompted to place a new diskette in the drive.    As each diskette 
fills up, the end-user is prompted for another disk, until the whole Zip file has been written. 
Do not choose this option if the Zip file is being written to a non-removable disk. This will cause a syntax 
error. Also, when doing a multi-volume zipping operation, the source files may not be on the same drive as the Zip 
file.
Once you have created a multi-volume Zip file, it cannot be modified in any way. You also cannot convert an 
existing non-multi-volume Zip file into a multi-volume type.



This indicates whether an alternate location is used to hold any temporary Zip file created during Zip operations. 
When the operation is complete, the temporary file is copied over the original Zip file and is deleted from the 
temporary path.
This option is useful when your target drive does not have the space to hold both the old and temporary Zip files at 
the same time.



This will allow you to enter a comment into the Zip file. This comment can be up to 2,047 characters long



The range is from 0 To 10, with 10 being maximum compression. If 0 is chosen, the files will not be compressed at 
all.



Add: Adds the specified files to a Zip file. If the Zip file does not already exist, it is created.    When a multi-volume 
operation is being performed, this action always creates a new Zip file.



Replaces an existing item in a Zip file only if it has been modified more recently than the version in the Zip file.    The
full name and path must match exactly if an item is to be replaced.    Unlike the Update action, this action does not 
add an item if that item does not already exist in the Zip file. This action may not be used if a multi-volume operation
is being performed.



Update: Adds any new files to the Zip file and replaces any existing items that have been modified more recently 
than their corresponding versions in the Zip file. The full name and path must match exactly if an item is to be 
replaced. This action may not be used if a multi-volume operation is being performed.



This invokes a dialog which will accept wildcard entries to be added to the Files To Be Added list. These include 
the standard DOS wildcards * and ?, where * represents a group of characters and ? represents a single character.



Clicking on this button will add the entire contents of the open directory in the directory list box to the Files To Be 
Added list.



Clicking on this button will add the selected files in the file list box to the Files To Be Added list. If no files are 
selected, no action will occur.



This will remove any files selected from the Files To Be Added list. If no files are selected, no action will occur.



Clicking on this button will remove the entire contents of the Files To Be Added list.



Clicking here will cause the actual zipping process to begin.



This will bring up the Zip Options dialog, which will allow you to both view and set the Zip parameters currently 
being used. These options can be set just for the file you are currently working on, or saved as the default, as you 
wish.



This will simply close the dialog, and return you to the main screen.



This list represents the files to be added to the Zip file. You can add files, directories, and special wildcard entries to 
this file list. Once the list is set, click on OK to begin the zipping process.



Use this file selection area to add whatever files and directories you wish to the Files To Be Added list, for inclusion
in the Zip file. You can use your mouse to select as many files as you like, and then click on the appropriate button 
below to accomplish this.



You can use this area to select a default text editor or viewer. Double-clicking on a file name listed within a Zip file in
the main dialog will allow you to view the contents of the file with that viewer. The default is Quick View, but feel 
free to change it to whatever you wish. Any changes you make will be saved when you exit the dialog.



If this box is checked, the individual windows that open each time you load a Zip file will fill the main program screen
completely, instead of opening in the default tiled method. You must restart the program for this to take effect.



This will allow you to open a Zip file with ZipWorks by simply double-clicking on it while in Explorer. We highly 
recommend that you take advantage of this very useful feature, which will add 3 right-click menu items to your 
appropriate zip files in Explorer - open, UnZip, and UnZip To Path.



Click here to exit the dialog. Any changes you make will be saved upon exit.



Deletes text from a document and places it onto the Clipboard, replacing the previous Clipboard contents.



Copies text from a document onto the Clipboard, leaving the original intact and replacing the previous Clipboard 
contents.



Pastes a copy of the Clipboard contents at the insertion point    or replaces selected text in a document.



Clicking here will prompt ZipWorks to write the contents of the text box to the comment field of the Zip file. You can 
add to the comment, completely change it, or delete the comment from the text box before clicking on Add to make 
these modifications.



Closes the Comment dialog.



This will simply open a new window.



This will invoke a dialog that will allow you to select a name for a Zip file that you wish to create. Once you have 
selected the name, the Add Files dialog will appear, allowing you to choose the files to add to your Zip file.



This will invoke a dialog that will allow you to choose an existing Zip file to display in the list box. Once opened, you 
can employ a wide variety of functions to modify, unZip, or delete the opened file.



This will unZip the currently selected files in the loaded Zip file. If no files are selected, a dialog will ask you if you 
wish to unZip the entire file. In either case, a dialog will then appear, requesting a destination directory for the unZip 
operation.



This is similar to New Zip File, and, in fact, is exactly the same if there is no Zip file currectly loaded. If there is a Zip 
file loaded, however, you’ll go straight to the Add Files dialog to do just that to the file.



As the name implies, this is exactly the opposite of Add Files. You must first use your mouse to select the files you 
would like to remove from the currently loaded Zip file. If you select all of the files, a dialog will ask if you would like 
to delete the file from your disk.



This will invoke a dialog that will allow you to add, eliminate, or modify a comment in a Zip file. As the name implies, 
a comment is a short (2047 characters max) text entry that is saved as a string within the file.



This will quickly select all of the files within the curently load Zip file.



This will quickly un-select all of the files within the currently loaded Zip file.



As the name implies, this will cause ZipWorks to close.



This will close the active window, but only if there is more than one window open. 



Menu Items

File Menu
Action Menu
View Menu
Options Menu
Sort Menu
Window Menu



FileMenu
New Window
New Zip File
Open Zip File
Close Window
Rename Zip File
Delete Zip File
Exit



Action Menu
Add To Zip File
Extract From Zip File
Delete From Zip File
Fix Corrupted Archive
Test Archive Integrity
Zip2Exe
Convert



As the name says, if ZipWorks cannot unzip a file, and reports that the archive is corrupt, employ this menu item to 
attempt to effect a repair. First, the program will attempt to rebuild the internal Zip header of the file if it finds some of
the file missing. If that fails to do the trick, ZipWorks will attempt to fix the file by trying to redetermine the 
compressed size of each item. This function cannot be employed on a spanned Zip file. If such a file is 
damaged in any way, the contents are not recoverable.



View Menu
View Selected File
Show Path Information
View/Edit Comment



Due to the limitations of space, the program’s main dialog will show only the file name of each file contained within 
the Zip file. If there is a directory structure stored in the file, the full path to each file can be displayed by choosing 
this menu item.



Options Menu
Zip Options
UnZip Option
Preferences



Registration
Ensign Systems
21 Tredown Road

Sydenham, London
SE26 5QQ

United Kingdom

This program is shareware, and, as such, may be used freely for a period of 30 days. If, after the 30 day 
evaluation period expires, you find this nifty little utility useful, and plan to continue using it, you are 
required to register the program.
By supporting the shareware concept you are helping to ensure its continuation, which, I think youll 
agree, will benefit us all
If you wish to register the program, we do accept VISA and MASTER CARD. Our registration phone 
number is 0181-778-2871 (FAX - 0181-776-8477). The cost of registration is £15.50. If you would like a 
copy of the program on diskette, there is an additional £2.50 shipping and handling charge.
If you prefer mail, please send a check in the amount of £15.50 to the above address. Be sure to include
your name, address, e-mail address, and the exact name of the program, so that we can immediately 
send you the registration information. If you would like a copy of the program on diskette, there is an 
additional £2.50 shipping and handling charge.
Upon receiving the check, we will e-mail you the registration code immediately. If you have any 
questions or comments, please don't hesitate to drop us a line. To reach Ensign Systems by e-mail:

ENsignPub@aol.com 



On-Line Support
On-line support can be accessed through the CT Software Forum on America Online (keyword: CT 
Software). All of our programs and required support files can be easily found there, as well as the CT 
Software Message Board. In addition, valuable tips and information are posted regularly in our Tip Of 
The Day feature!
Please feel free to visit our World Wide Web site, from which you can download all of our software, and 
access complete product descriptions of the very latest versions of the shareware offered by CT 
Software, in addition to offering links to many other excellent shareware sources. The CT Software 
Home Page URL is: 

"http://members.aol.com/ron2222"



Other Programs by CT Software
CT Calendar
CT Calendar is a small 32-Bit desktop calendar. We have tried to keep it small enough to keep on your desktop, but
not so small that you need a magnifying glass to see it. It has many customizable features including color and 
loading position.This program is free of charge with the registration of any CT Software 32-bit shareware program.

CT HotSpot
CT HotSpot is a small utility with which you can create 2 hotspots - 1 to turn your screensaver on, and the other to 
turn it off. This can be quite useful when downloading a large file, doing a tape backup, or when using the Windows 
95 utility, DEFRAG. Having a screensaver come on during any of these activities can wreck havoc with your 
computer and your files.

DiskCopy
DiskCopy is a simple little 32-Bit program for formatting and creating duplicate disks. DiskCopy will prompt you for 
the number of copies you have in mind, making for a very quick operation. DiskCopy does not perform an actual 
track by track copy, it simply copies the directory structure and files, but 99% of the time, that is all that is really 
required.

FormPost Edit
FormPost Edit is a special text editor for those of us who have to contend with posted Web forms. In addition to the
many standard editing capabilities that the program has, its specialty is interpreting the extraneous characters 
contained in posted Web forms, turning them into easily readable text. Of course FormPost Edit can then either 
save or rename the form, as you wish, and also send it to your printer. In addition: 
1.) FormPost Edit offers full font and color control, and will save your settings. 
2.) FormPost Edit features a toolbar, complete with help balloons, which can be toggled on and off, as you wish. 
3.) FormPost Edit will allow you to both print and save to a file selected text only, if desired. Simply select the text 
with the cursor before invoking the print or save as command, and only the selected text will be considered.

Notebook for Windows 95
There is one, and only one point to this program - to replace Notepad. Notebook is not a word processor. It's sole 
purpose is to view and edit text files. Notebook does have 6 major features (and several minor ones) which we 
believe make up for Notepad's inadequacies:
1. It will open very large files, and allow you to edit them.
2. It features full font control - you can set the font name, style, size, and color, and your settings will be saved when
you exit the program. It will look better on your screen, and do a much better job of printing.
3. Notebook has a toolbar complete with help balloons.
4. Notebook features DRAG AND DROP text editing. If you want to move a block of text, just use the mouse to 
select it, and drag it to where you want it.
5. Notebook supports overtype mode. While the default editing mode is insert, hitting the INSERT key on your 
keyboard will change that to overtype.
6. Notebook can both print and/or save to a file selected text only, if desired.

Safety Net Pro
Safety Net Pro is a highly acclaimed utility for backing up key files by file extension. It has one default setting - to 
backup key "windows" and system files including INI files, Registry Files, CONFIG.SYS, and AUTOEXEC.BAT- and 
5 user configurable options. Safety Net Pro could easily backup all of the document and/or database files on your 
drive, for example, with the directory structure intact, and it can Zip them to disk. Safety Net Pro has several 
advanced, including built-in 32-bit zip compression (PKZ v2.04 compatible) and the ability to span Zip files across 
multiple disks Safety Net Pro can also print file lists, print your directory tree, and make a boot disk.

Winsock Swapper
The purpose of Winsock Swapper is to automate the process of swapping various WINSOCK.DLL files for those of
you who use more than one Internet service provider with your default Web Browser. With one quick double-click, 
you can swap up to three DLL's, and optionally launch your browser. It doesn’t get any easier than that!



YahtC
This game is a clone of the immensely popular game, Yahtzee. YahtC combines attractive 3D graphics with 
extreme ease of use. There are no complicated instructions, and no hidden forms. Each player's score is always 
visible. A sound card, while certainly not necessary, will greatly enhance the game, which produces sound effects 
when a player rolls the dice, "zeroes" out a scoring category, or rolls a "YahtC". The game will also keep a 
permanent record of High Scores, which can be easily cleared at any time. YahtC is fully functional, and supports 
up to 4 players.



This will invoke the UnZip Options dialog which will allow you to choose from several options regarding the 
unzipping of your archives. These options can be applied to only the task at hand, or saved as your default choice.



This will bring up a dialog that will allow you to choose a default text editor or viewer. Double-clicking on a file name 
listed within a Zip file in the main dialog will allow you to view the contents of the file with that viewer. The default is 
Quick View, but feel free to change it to whatever you wish. Any changes you make will be saved when you exit the
dialog. You can also choose how the individual windows appear as they are called. If you prefer, they can fill the 
main program screen completely, instead of opening in the default tiled method. You must restart the program for 
this to take effect. In addition, from here you can choose to associate Zip files with Explorer.



Use this dialog to specify where you would like ZipWorks to deposit the unzipped files. You can either select a path 
using the file selection area, or simply type in the path you prefer. If the path you enter does not exist, ZipWorks will
create it, if at all possible. Once you have selected your path, clicking on OK will start the actual unzipping process.



This option affects how ZipWorks reacts to being called from the command option. What this means is simply this: 
you can associate ZipWorks with Zip files in Explorer, and you can also drop a shortcut in the Send To folder in 
your Windows directory. This will allow you to run ZipWorks by sending a file to it via your Send To menu, or by 
simply double-clicking on a Zip file in Explorer. If this box is unchecked, invoking the program in that method will 
simply result in ZipWorks loading the file, and awaiting your instructions. If this box is checked, however, the file 
will be loaded, and unzipped right where it is - no questions asked.



Sort Menu
The Sort Menu allows you to sort the contents of the current window according to various criteria. When an archive 
is first opened, it is unsorted: the files appear in the order in which they appear inside the archive. You can choose 
to sort them by choosing one of the commands under the Sort Menu.



Window Menu
The Window Menu allows you to control the positions of the windows of    the ZipWorks MDI Interface. You can use 
the commands of this menu to arrange all displayed windows or to bring any open window to the top.



Compatibility

Zip files created with ZipWorks are completely compatible with the PKZIP v2.04 format, with one exception. While 
ZipWorks can certainly handle any file created by that utility, the opposite is only almost always true. If an archive 
created by ZipWorks contains long filenames, a 16 bit unzipping utility will generally truncate those names during 
the unzipping process - no big deal. A problem can arise, however, when those long filenames contain charaters 
that are “16 bit illegal”. An example of this would be a SPACE. The file “MY REPORT CARD”, for example, would 
almost certainly cause a 16 bit unzipping utility to fail in the attempt. If this is a concern, ZipWorks provides a simple
way around this. You can set the program to    shorten long filenames before creating the archive.



ZipWorks Order Form
Ensign Systems
21 Tredown Road

Sydenham, London
SE26 5QQ

United Kingdom
0181-778-2871 (FAX - 0181-776-8477)

Name____________________________________________________________________

Address(1)________________________________________________________________ 

Address(2)________________________________________________________________

City______________________________________________________________________

State_______________________________Zip-Code______________________________

Country__________________________________________________________________

Phone_______________________E-Mail_______________________________________

Payment Method

Check_____________Visa_____________Master-Card______________AX____________

Credit Card No._______________________________________Exp.-Date______________

Register________Copies of ZipWorks at £15.50 Include_______Disks(£2.50)



This will allow you to view the contents of a selected file that is in the currently loaded Zip file with your default 
viewer. The default is QuickView, but you can choose a different viewer, if you wish, by accesssing the 
Preferences dialog in the Options menu. You must first use your mouse to select one and only one file from the list
to view.



If you have need to convert Zip files to the PKZIP v1.10 format, you can enable that function by checking the box in 
the Preferences dialog. You will be prompted immediately for the location of your PKZIP.EXE file, and a new menu 
item, Convert, will appear in the Action menu. Choosing that menu item will immediately put that operation into 
motion. The currently loaded file will be saved with a BAK extension, and then converted along the existing path.



This will allow you to rename the currently loaded Zip file. A dialog will appear that will allow you to specify a new 
path for the file, as well.



If you want to kiss the currently loaded Zip file goodby, this is the way to go. You will be prompted for 
confirmation before the deed is done.



This menu item will only appear if you enable this function from the Preferences dialog.



Wildcard Entries
ZipWorks will accept wildcard entries to add to Zip files in the following way: From the Add Files dialog, select the 
Add Special button. You can freely enter anything you want in the 5 text boxes here, and your entries will be added 
to the Add Files list upon closing the dialog. These entries can include the standard DOS wildcards * and ?, where *
represents a group of characters and ? represents a single character. For example, if you want your Zip file to 
include all INI files located in your Windows directory, you might enter c:\windows\*.ini. Assuming the you Windows
directory is located on your C: drive, that would do the trick. If you want to Zip all of the INI and INF files from your 
Windows directory, then enter c:\windows\*.in?. There is really no way to trap for user input error here, so be 
certain that your entries are correct. If the complete path is not entered, or your entry is invalid in any other way, 
ZipWorks will fail to find the files.



This will allow you to set or change your path to the file ZIP2EXE.EXE, which is currently required to convert Zip 
files to executable Zip files.



This function shells to the file ZIP2EXE.EXE, in order to create an executable Zip file. You must specify your path to 
that file in order for this to function.



Double-clicking on a file here will allow you to view its contents with your default viewer. The default is QuickView, 
but you can choose a different viewer, if you wish, by accesssing the Preferences dialog in the Options menu. You 
must first use your mouse to select one and only one file from the list to view.






